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Introduction 
Congratulations on the purchase of your new F-950 Three Gas 

Analyzer! 

The new F-950 Three Gas Analyzer measures three critical 

gases: ethylene (C2H4), carbon dioxide (CO2) and oxygen (O2), to 

maintain optimum produce quality at every phase. 

The F-950 is used to: 

 Inspect storage and packing environments  

 Verify ethylene mitigation efficacy  

 Optimize ripening storage atmosphere conditions  

 Quality assure MAP (Modified Atmosphere Packaging) 

for ethylene-sensitive products 

Ethylene affects ripening, aging, and spoilage in produce. The F-

950 measures levels of ethylene, CO2 and O2 in the atmosphere, 

and can be scaled to many environments, from cold storage to 

warehouse to transportation container.  

Simple to operate and weighing less than a kilogram, the F-950 

uses an electrochemical cell to measure ethylene between 0-

200 ppm in air. It records date, time, relative humidity, 

temperature, and GPS location. The F-950 is ideal for measuring 

ethylene production across a wide range of fruit or floral types 

and is especially suitable for managing ethylene emissions from 

perishable cut produce products. 
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The F-950 is ideal for Modified Atmosphere Packaging (MAP) 

applications. Most MAP gas analyzers are only equipped to 

measure CO2 and/or O2 concentrations. Quality assurance for 

perishable cut produce demands a more comprehensive 

analysis. The F-950 makes it possible to respond to the change 

in ripening gases to ensure longer shelf-life and higher quality 

commodities. 

We hope you enjoy using your F-950 Three Gas Analyzer. 
 

    

mailto:sales@felixinstruments.com
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Features  
 Portable, lightweight and easy to operate. 

Rapid response time, with data points saved every second.  

 

 Repeatable, precise measurements. 

 

 Two versatile modes of operation  
Measure in Continuous or Trigger mode depending on your 

application.  

 

 True sunlight readable transflective display. 
The contrast of the display increases under brighter sunlight.  

 

 Removable, re-chargeable standard sized batteries. 
Included stand-alone battery charger enables charging one battery 

set while using another. Two sets of batteries are included with the 

device. Additional button-top 19670 (or protected 18650) batteries 

can be purchased from your preferred battery vendor. 
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Specifications 

F-950 Specifications 

Air Sampling Rate 70 mL/min  

Measuring Rate Automated; 1 sec intervals 

Data Storage Removable 16 GB SD card 

Display Sunlight visible transflective LCD 

Operating environment 
0°C - 50°C (15-90% humidity non-
condensing) 

Battery Capacity 8.5 hours 

Dimensions 18 x 13.5 x 5.5 cm 

Weight 1.0 Kg 

Enclosure Powder coated aluminum 

Warm-up time < 2 minutes 

Sensors 

Ethylene Sensor  Electrochemical 
Nominal Range 0 – 200 ppm  

Lower Detection Limit 0.2 ppm 

Resolution 0.1 ppm 

Accuracy 

± 5% relative; ±0.2 ppm absolute in 
Continuous mode  
±5% relative; ±0.15ppm absolute in 
Trigger mode 

Carbon Dioxide 
Sensor  Infrared Sensor, Pyroelectric detector 
Nominal Range 0 – 100%  

Full scale resolution  0.01%  

Accuracy 

± 3% relative; ±0.01% absolute in 
Continuous mode  
±3% relative; ±0.50% absolute in 
Trigger mode 

Oxygen Sensor Electrochemical 

mailto:sales@felixinstruments.com
http://www.felixinstruments.com/
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Nominal Range 0-100% 

Resolution 0.1% 

Accuracy 

± 2% relative; ±0.10% absolute in 
Continuous mode  
±2% relative; ±0.3% absolute in 
Trigger mode 

Unpacking the F-950 
The F-950 arrives with a hard-sided carrying case, two sets of 

batteries and a charger, a removable 16 GB SD card, and several 

accessory parts. The unit comes with an external conditioning 

chamber and potassium permanganate (KMnO4), used to scrub 

the air entering the system. A sampling port with needle is 

included for sampling from packaging and an external PolarCept 

filter for reducing interfering gases. The sampling port is 

pictured below, connected to the intake. 
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Operating Instructions 
WARNING: Do not store the F-950 without batteries! Charged 

batteries must be present in the instrument to maintain the 

accuracy of the sensors, even when the unit is powered off. 

If the batteries of the F-950 discharge during storage, replace 

with charged batteries and allow the instrument to stabilize 48 

hours before use. There is a small internal battery to maintain 

the bias voltage for the ethylene electrochemical sensor. This 

small internal battery will last for 1 day without the main 

batteries before sensor sensitivity is affected by losing its bias 

voltage. The calibration parameter data is intact with or without 

batteries.  

mailto:sales@felixinstruments.com
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Fully charged main batteries allow for storage time of over 1 

year.  For long-term storage, consider attaching the potassium 

permanganate (KMnO4) external conditioning chamber to the 

inlet and outlet of the F-950 (see image below).  

 

 Aged batteries or batteries that started out with less charge will 

reduce the storage time available. The Li-ion batteries have little 

self-discharge and a life of about 3 years.   

 

Loading the Battery 
The F-950 uses 18650 Li-ion 3.7V 3100mAh rechargeable 

batteries. For longer lifespan, charge the batteries at 0.25A. For 

a faster charge, charge at 1A. The batteries must be removed 

from the F-950 to be charged.  
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To remove the batteries, twist the battery compartment cap, 

located on the bottom of the case. The cap can be twisted with 

fingers or a screw-driver to tighten or loosen. Take care when 

removing batteries, as the cap is spring loaded. Both batteries 

should be inserted into the unit positive (+) side first (towards 

intake or top). The battery compartment is pictured below. 

 

  

mailto:sales@felixinstruments.com
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Basic Operation 
To turn the instrument on, press the green power button. The 

Felix Instruments logo will flash, followed by the main menu. 

The top of the display reads Felix Instruments, and the current 

version of firmware the unit is running is displayed in the lower 

left hand corner. The battery meter is listed on the lower right 

hand side of the display.  

For information on the latest firmware version, please visit the 

F-950 support webpage (www.felixinstruments.com/support/f-

950-support).  

The main menu displays the following options: Measure, Setup, 

and File. If the green power button is pressed, the display will 

prompt for confirmation before shutting off the F-950.  

 

To scroll between menu items in the list, use the Up and Down 

arrows. To select an option from the menu list, use the Right 

arrow. To exit, use the Left arrow.  

http://www.felixinstruments.com/support/f-950-support
http://www.felixinstruments.com/support/f-950-support
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Measurement Modes 
Two measurement modes are present on the F-950: Continuous 

mode and Trigger mode. To change measurement mode, go to 

Setup > Mode from the main menu. 

Presence of volatile organic compounds (VOC’s) other than 

ethylene in the sample environment can lead to falsely high 

ethylene readings with the F-950. VOC’s are aromatic 

compounds like ethylene, esters and alcohols. Their production 

increase with produce aging and spoilage. The F-950 ethylene 

sensor cannot distinguish ethylene from many other VOC’s. 

PolarCept was designed to optimize and improve the accuracy 

of ethylene measurements. PolarCept is an external water filter, 

which reduces the signal from interfering gases reaching the 

ethylene sensor. PolarCept is recommended in Trigger mode. 

PolarCept dramatically reduces the amount of interfering gases 

like alcohols and esters that are present in a sample, allowing 

ethylene to pass through to the sensors. For more information 

on Polarcept see page 12. 

Continuous measurement mode measures the air entering 

through the input of the instrument. The controls default to 

Loop “open” and Pump “on”. Continuous mode can be used 

with or without the sample port attached to the front of the 

instrument. The data is saved every one second in continuous 

mode. 

Trigger measurement mode begins with the valve closed and 

the pump off. To start taking a measurement, press the square 

start button on the key-strip of the F-950 to initiate a new 

measurement. The pump will run and 30-40mL of gas will be 

drawn into the instrument for analysis. The final values of the 

analysis will be displayed on the screen and the measurement 

mailto:sales@felixinstruments.com
http://www.felixinstruments.com/
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saved to the SD card. The pump will then turn off until the user 

initiates a new measurement.  

Trigger mode can be used with or without the sample port 

attached to the front of the instrument. The instrument will 

detect and report total VOC’s present in the sample. 

Trigger mode should be used in place of continuous mode if 

expecting high ethylene concentrations.  Trigger mode allows a 

purge of the internal volume of gas in the instrument between 

samples and will help protect the ethylene sensor from over-

saturation.   

Passcode Protection 
Certain menu systems on the F-950 are protected by a passcode 

setting. These menu systems include Parameters, Set Zero, 

Calibration, and Factory Setup. The default code for entry is 

‘1111’. The passcode only needs to be entered once for each 

reboot of the device. If the device is powered off, the passcode 

will need to be entered again for entry into the menu systems 

described above.  

To set the passcode to a four-digit code other than the default 

setting, please follow the steps below. 

1. Open SD card on PC 

2. Click the ‘View’ tab in the taskbar 

3. Click ‘Options’ in the far right of the toolbar 

4. Open the ‘View’ tab 

5. Scroll down and uncheck the box named ‘Hide 

protected operating systems (Recommended)’ 

6. Check the box named ‘Show hidden files, folders, and 

drives’ 
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7. Click ‘Yes’ 

8. Click ‘Apply’ and then click ‘OK’ 

9. Open the Config.txt file that should now appear inside 

the SD card 

10. Alter the ‘1111’ to four-digit numeric passcode desired 

11. Save the changes 

12. Insert SD card back into Gas Analyzer 

 

 

 

  

mailto:sales@felixinstruments.com
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Interfering Gases 
No analytical method is completely specific. Gases present in 
the environment, other than the “target” gas of a 
measurement, may affect instrument response. Interferences 
are not necessarily linear, and may also exhibit time dependent 
characteristics.  
 
Ripening fruit emit a complex mixture of hydrocarbons, 

including ethylene. Oxidation of these other gases in the 

electrochemical sensor cannot be readily distinguished from 

ethylene. This causes the ethylene value to be falsely high in the 

presence of interfering gas.  

Felix Instruments has tested a method to absorb some of the 

competing gases and provide better ethylene measurements. 

This method, PolarCept, uses distilled water in an external 

chamber and has been shown to filter out some polar 

hydrocarbons and alcohols to produce less interference.  

PolarCept 
It is recommended to use the external PolarCept filter when 

measuring a mixture of gas (such as when sampling fruit) or 

interfering gases may be reported by the instrument. The 

external filter can be used with either of the measurement 

modes, and is recommended for Trigger mode. PolarCept 

should only be used with 1.5 mL of distilled or deionized water.  
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The PolarCept filter consists of a plastic molded part, 

hydrophobic filter and O-ring. It is also used with the sampling 

probe tubing and sample probe needle. A small plastic syringe is 

used to fill and empty PolarCept. Once the hydrophobic filter 

and O-ring are in place, it should be very difficult to remove it, 

creating a leak-proof seal. Additional hydrophobic filters are 

included as replacements, when the filter is soaked with water 

or damaged during removal.   

Eventually the water in the PolarCept filter will become 

saturated with trapped interfering gases and should be replaced 

with fresh distilled water. Saturation rates will depend on the 

measurement mode and amount of interfering gases present in 

the sample environment. The table below shows example 

saturation times when measuring headspace of bananas (with a 

maturity index of 5) in Continuous mode. This sample contains 

mailto:sales@felixinstruments.com
http://www.felixinstruments.com/
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various mixed hydrocarbons, ethylene and VOCs.  The total VOC 

in ppm listed is the signal reported by the C2H4 sensor in ppm.  

VOC concentration PolarCept saturation (min) 

3 ppm 20 

100 ppm 1 

 
To fill the PolarCept filter, attach an empty syringe to the 

hydrophobic filter. The plunger of the syringe should be 

completely depressed. Lower PolarCept over a cup of distilled 

water and draw in 1.5 mL with the syringe. Attach the sample 

needle and sample tubing to stop leaks. To empty PolarCept, re-

attach the syringe and push the water out the sample needle 

end.   
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To properly use PolarCept, keep the sample needle pointed 

downwards while measuring, as seen in the example below on 

the left. The water in the filter should “bubble” as the gas 

sample is pulled through it, causing some of the interfering 

gases to be trapped.   

 

See the following graph of measured ethylene concentration by 

the F-950 with and without using PolarCept, measuring the 

same headspace of bananas.  After about 20 minutes, the water 

becomes saturated, and the signal beings to rise with PolarCept.   

  

mailto:sales@felixinstruments.com
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Measure 
From the main menu, press the right arrow when the word 

Measure is highlighted, to enter the measurement display 

screen. All measurement variables are saved to the SD card 

every 1 second in Continuous mode. When the SD card is not 

present, the data will not be saved. 

If sampling very high concentrations followed by very low 

concentrations, allow the instrument time to purge internal gas 

for the most accurate measurements.   

Continuous Mode 
When in Continuous mode, a graph of the concentration of each 

gas can be viewed over time. The default graph shown is the 

ethylene (C2H4) concentration in ppm. To view the graph of the 

other gases, simply use the up and down arrows to scroll 

through them. The current gas being graphed is shown on the 

top of the screen with the concentration in large font as shown 

below.  

 

mailto:sales@felixinstruments.com
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The x-axis of the graph is time. The y-axis of the graph displays 

the range of the concentration (in ppm for ethylene and % for 

CO2 and O2), and the dynamic range is labeled at the top. The y-

axis scale is set by the highest value shown in the buffer. This 

range will scale vertically, dependent on the highest 

concentration of gas measured. If the concentration is small, 

the dynamic range will reflect this.   

The graph begins on the left side and moves towards the right 

as more data points are added. Once the line reaches the right 

side of the display, the data will begin moving towards the far 

left, keeping the current time at the far right. The total 

measurement time is displayed below the graph.  

Current oxygen (% O2) and carbon dioxide (% CO2) 

concentrations are listed on the right side of the graph when 

ethylene is being graphed. This data changes slightly when 

displaying the graph of other gas concentrations. The flowrate 

(mL/m) is displayed at the bottom. If Relative Humidity (% RH) 

and Temperature (degrees Celsius) are not seen on the display, 

go to Setup>RH Conversion and enter the actual temperature of 

the measurement gas (see page 

Ref477940541 \h 28).  
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Trigger Mode 
A measurement in trigger mode begins with the valves closed 

and the pump off. To begin, press the square start button as 

prompted, to measure. This will turn on the pump and the 

ethylene sensor will stabilize before drawing in sample gas. 

Trigger mode will take longer to stabilize if the concentration is 

in a different range from the last sample (30 sec-1.5 min).  

 

 

The pump will draw in 30-40mL of the gas sample and then 

display the final values on the display screen. The results will be 

saved to the SD card.  

mailto:sales@felixinstruments.com
http://www.felixinstruments.com/


F-950 Instruction Manual rev. 6/20/2017 

 

1554 NE 3rd Ave, Camas, WA 98607, USA                               21 

Phone: (360) 833-8835   
sales@felixinstruments.com  
www.felixinstruments.com 

 

After the final values are displayed, the F-950 will read ‘Purging’ 

in the lower left-hand corner. During purging, the valves are 

closed and the instrument is running the gas sample through 

the internal potassium permanganate (KMnO4) chamber to 

purge the instrument of residual ethylene.  

Once purging is complete, press the square start button to 

begin another measurement. Press the Left arrow to exit to the 

main menu.  

Trigger mode can be used with or without the sample probe 
and needle attached. Assemble the probe by connecting the 
black tubing to the intake of the F-950. Next, twist on a 
hydrophobic filter to the end of the tubing. The filter will 
prevent any moisture or debris from being sucked into the 
instrument. Finally, attach a sterile needle to the filter. 
Depending on the application, needles can be re-used.  
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Auto-Escape Feature 
An upper limit auto-escape feature acts as a safety feature of 

the unit. This safety feature is always on. If the sensor detects 

over 200 ppm ethylene, the F-950 will auto-escape from 

monitor mode to prevent poisoning the electrode in the 

ethylene sensor. This will stop the measurement.  

If the sensor becomes poisoned, it will continually auto-escape 

with the error message "sensor out of bounds". If this message 

appears, connect the external conditioning tube filled 

completely with potassium permanganate (KMnO4) to the 

inlet/outlet of the F-950. Allow time with the instrument 

powered on (Continuous Mode) to remove the high 

concentration of ethylene in the instrument.  
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Setup 
Use the right arrow to enter the Setup Menu from the Main 

Menu screen. 

The F-950 has a number of utility functions that allow the user 

to manage the instrument’s capabilities. Eight setup functions 

are available: Mode, Set Zero, Calibration, Date & Time, RH 

Conversion, GPS, Language, and Factory Setup.  

Setup Mode 
Setup Mode allows the user to change the measurement mode 

of the instrument between Continuous and Trigger mode. To 

change the mode, highlight Measure and use the right arrow to 

highlight the mode. Then use the Up/Down arrows to cycle 

through the mode options. Use the left arrow to highlight 

Measure once the correct mode has been selected. Then press 

the left arrow again to exit to the main menu. 

 

USB mode should be set to USB Storage. Bluetooth and USB Ctrl 

are the other available options to be used in conjunction with 

mailto:sales@felixinstruments.com
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the F-950 Gas Analysis Software (G.A.S.). More information 

about these connection options can be found on page 

39 of the manual.  

0580 \h 39 of the manual.  

Setup Set Zero 
Setup Set Zero sets a new baseline, or zero, for the C2H4, CO2, 

and O2 sensors. All sensors should be zeroed weekly. While in 

the set zero menu, press the right arrow to set zero for your 

desired sensor. The set zero process can be completed for all 

sensors in the instrument without the use of standardized 

gases.  

Ethylene Set Zero 

The set zero process for the ethylene sensor utilizes a small 

chamber of KMnO4 that is located inside the instrument. After 

initializing the set zero process, the display will read ‘Use fresh 

air’ and ‘Please wait…’. A countdown to the completion of the 

set zero process can be viewed in the upper right corner. The 

offset value will be displayed on the screen as well.  

Once the offset is completed the screen will flash ‘OK’ if the 
offset value was successfully reset by the set zero process. The 
display screen will automatically return you to the set zero 
menu.  
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CO2 Set Zero 

Pressing the right arrow while the CO2 sensor is highlighted in 
the set zero main menu will cause the display to prompt you to 
hook up 100% N2 gas or create a 0ppm environment for CO2. To 
create the 0ppm environment, use the external conditioning 
chamber, provided with the unit, full of soda lime. Connect one 
end of the tubing to the intake on the instrument and the other 
end to the outtake. The soda lime will scrub the gas flow of CO2, 
creating a 0ppm environment for a successful set zero.  
 
Once the soda lime is hooked up with the instrument, press the 
right arrow to initiate the set zero process. Like the ethylene set 
zero, the display will show a countdown to completion and an 
offset value. ‘OK’ will flash when the set zero process has been 
completed.  

O2 Set Zero 

Pressing the right arrow while the O2 sensor is highlighted in the 

set zero menu will initiate the offset value for the O2 sensor. 

Setting a true zero for the O2 sensor requires the use of 100% N2 

gas. For the O2 sensor, an alternative calibration, O2 calibration 

in air, can be used instead of setting zero with 100% N2 gas. 

Please see the ‘O2 Calibration in Air’ section for more details on 

this process.  

Setup Calibration 
The calibration feature allows the user to set zero and set span 

without the use of a computer or G.A.S. (Gas Analysis Software). 

Unlike Setup > Set Zero in the previous section, a zero-standard 

gas is required as well as standard gases for the set span 

process. 

The F-950 will prompt the user to set up a zero gas, which can 

be achieved by feeding 100% Nitrogen (N2) gas to the intake. 

mailto:sales@felixinstruments.com
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The unit will countdown to set zero. The following screen will 

prompt the user to setup a span gas, which is a known standard 

gas used for the span calibration process. Please refer to the 

table below for the appropriate standard gases to use for span 

calibrations.  

 

 

 Set zero Set span Verification 

Ethylene 

 

Potassium 

permanganate 

(KMnO4)  

100ppm 

C2H4 

75ppm C2H4 

Carbon 

dioxide 

(CO2) 

 

Soda lime or 

100% N2 

95% CO2 16% CO2 

Oxygen (O2) 

 

Ambient air or 

100% N2 

50% O2 Ambient air 

 

While the span calibration is running, the display will show what 

the instrument is currently measuring as the concentration of 

the standard gas. After giving the sensors 5-10 minutes to 

stabilize, use the up and down arrow keys to adjust the 

concentration to the actual concentration of the standard gas 

tank.  

It is important to verify the calibration as successful after 

completion. Typically, it is best to run the verification process 
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the day after the calibration. To verify the calibration, connect 

your verification standard gas and take a measurement in 

Continuous mode. Give the sensors 2-3 minutes to stabilize and 

then ensure that the reported concentration is falling within the 

accuracy range of the device.  

Setup > O2 Calibration in Air 
Alternative to setting zero for the oxygen sensor weekly with 

100% N2 gas, a user can use the O2 calibration in air menu 

option to calibrate the O2 sensor using ambient air.  

Right arrow on this menu option to begin the calibration. The 

display will read, ‘Use fresh air (20.9%) Please wait…’. The F-950 

will beep upon completion of the O2 calibration in air. 

Setup Date and Time 
Use the Right and Left arrows to move between 

Month/Day/Year and Hour/Minute/Second and use the Up and 

Down arrows to change the values. To exit, use the left arrow to 

back out of the screen and return to the Setup menu.  

Setup RH Conversion 
The Setup RH Conversion menu is used to correct for the 

temperature sensor being inside F-950 housing. This causes the 

temperature sensor to reflect the temperature of the F-950 and 

not the ambient temperature. The temperature is usually 

several degrees above ambient. The Relative Humidity is 

calculated based on temperature.  

Enter the correct ambient temperature in degrees Celsius, 

measured from an external temperature sensor, to have the F-

950 use for calculating the relative humidity (RH %). To use the 

mailto:sales@felixinstruments.com
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entered temperature for RH, “use sample T” should be set to 

“Yes.”  

The current (internal RH) and corrected (sample RH) relative 

humidity are displayed at the bottom of this screen.  

 

 

 

 

 

 

Setup GPS 
The GPS sensor inside of the F-950 can be used to record 

latitude and longitude to within 10 meters. The instrument 

should be operated outside, without overhead obstruction for 

best GPS performance. It may be difficult to acquire a fix on GPS 

satellites indoors. The Setup>GPS menu turns on or off the GPS 

sensor and show the current GPS data.  Data is also saved to the 

SDcard .csv file. 

 

 

 

 

 

 

RH Conversion 
Enter Sample T(C)       20.0 
Use Sample T                 Yes 
(for measurements) 
 
Internal RH (%)             43.6 
Sample RH (%)              21.3 

Setup GPS 

Enable GPS  Yes/No 

Acquiring GPS data….. 

Longitude                             122.558 

Latitude                                    45.59 
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Setup Language 
The F-950 Three Gas Analyzer now has options for Spanish and 

Portuguese languages for firmware 1.5.7.5 and above, to 

update your firmware refer to the Firmware Update portion of 

this manual. 

Setup Factory Settings 
The Setup > Factory Settings menu is used to back up or restore 

the factory defaults for the calibration parameters for all of the 

sensors (C2H4, CO2 and O2) on the device. The calibration 

parameters can also be modified using this menu. It is 

recommended to always back up the current parameters before 

making any modifications.   

To modify calibration parameters: 

1. Back up the current parameters (Setup>factory 
settings>back up) 

2. Make the modification in the .cfg file 
3. Import the .cfg file (Setup>factory settings>restore) to 

apply the changes 

File 
The File Menu is accessed by highlighting “File” on the Main 

Menu and pressing the right arrow key. Here, the user can 

manipulate files on the F-950. The F-950 remembers the last 

open file and will being saving data into it when it is powered 

back on. 

In the main file menu, four options are available: Select, New, 

Delete and Review. All files created by the F-950 are .csv 

(comma separated value) files.  
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To view data on a computer, simply insert the SD card into the 

computer’s SD card reader.  The computer should automatically 

detect the SD card as a new storage device and mount the drive 

so that measurement data will be accessible by any computer 

application. The mini-USB port can also be used to establish a 

USB connection with a computer to transfer data from the F-

950.  

File Select 
File Select displays a list of .csv files that exist on the F-950 SD 

card. Use the Up and Down arrows to move between files, and 

the right arrow to select a file to which new data will be saved. 

If the unit is powered on and no file is selected, the data will be 

default saved to the file “data.csv”. In the file, each data point is 

labeled with time and date for easy sorting.  

 

File Create 
Pressing the Right arrow when File Create is selected will create 

a new file according to the naming scheme programmed on the 
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instrument, XX_XX_XX_X or Year_Month_Date_Ordinal. For 

example, the first file created on September 8, 2014 will read 

14_09_08_0 and subsequent files will increase the last 

placeholder numerically. After pressing the right arrow, go to 

File Select to see the list of files on the SD card. There will be a 

new file in the list with the current date.  

File Delete 
File Delete displays a list of files that exist on the F-950 SD card. 

Use the Up and Down arrows to scroll between files and use the 

right arrow to display the option to delete the selected file. A 

message will appear that reads “Delete File?” Press the Left 

arrow for no, leaving the file intact. Press the Right arrow for 

yes, deleting the file.  
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File Review 
File Review displays a list of files that are on the SD card and 

allows you to view the data in the files. Use the Up and Down 

arrows to scroll between files and the right arrow to enter the 

selected file. The data.csv file is the default file, which data will 

be saved into if no other files are created.  

After selecting a file name, the measurement mode with time of 

the measurement and ethylene concentration will appear for 

Trigger mode readings. Use the Up and Down arrows to 

highlight a measurement and the Right arrow to enter the 

measurement and see the more detailed data, including CO2, 

O2, Temperature, Relative Humidity and Flow Rate.  
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Data Files on the Computer 
Open the data files saved on the SD card on the computer using 

Microsoft Excel or Notepad. Data files are saved as .csv 

(commas separated value). The following figure is an example 

data spreadsheet. Data values included are the date and time of 

the measurement, the measurement mode, the ethylene level 

in parts per million (ppm), the CO2 concentration in percent, the 

O2 concentration in percent, the temperature of the gas stream 

in degrees Celsius, the relative humidity (RH) of the gas stream 

in percent, and the flow rate of the gas stream in milliliters (mL) 

per minute.  

 

 

REMEMBER: Always save the data files to the computer before 

making changes or starting analysis.  
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Example spreadsheet data of an F-950 measurement.  

 

Wireless SD Memory Card Operation 
These instructions are meant to accompany the instructions 

supplied by the vendor for Toshiba FlashAir™ W-03 to use 

specifically with the F-950, which can be similarly applied to 

other Felix Instruments products. 

1. Install FlashAir™ Wi-Fi card software appropriate to the 

SD card. 

a. Visit https://www.toshiba.co.jp/p-

media/english/download/wl/software02.htm to 

download the software for configuring the Wi-Fi 

card and obtain vendor operation instructions. 

2. Insert the Wi-Fi card onto a personal computer (PC). 

3. Open the “FlashAirTool” on your PC to configure the SD 

card. 

4. Follow the configuration instructions prompted by the 

“FlashAirTool”. 

5. For additional guidelines, access the “Help” menu inside 

the “FlashAirTool” software. 

https://www.toshiba.co.jp/p-media/english/download/wl/software02.htm
https://www.toshiba.co.jp/p-media/english/download/wl/software02.htm
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6. The Wi-Fi card can be enabled in “internet pass thru 

mode”, outlined in the following documentation 

provided within the FlashAirTool software: 

• Go to Network Settings on the main menu 

Check Internet pass thru mode 

This function is available for FlashAir™ W-03 

and FlashAir™ W-02 (Ver. F19BAW3AW2.00.02 

or later) cards. 

 

When this function is enabled, the FlashAir™ 

card can be used like a router, by allowing 

another access point to be connected via the 

card. 

When an internet access point is connected, 

images stored on the FlashAir™ card can be 

viewed, and the internet can also be accessed. 

This is convenient when, for example, uploading 

image files downloaded form a FlashAir™ card 

onto social networking services, as there is no 
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need to change the Wi-fi device network 

settings on your smartphone. 

 

 

* CAUTION: If you want to connect to the internet without using 

the internet pass thru mode, the wireless LAN setting 

connection on 

your smartphone or other device must be 

changed from the FlashAir™ card to the internet 

access point. 

Check the “Enable internet pass thru mode” 

checkbox to enable “internet pass thru mode”.  

o Access Point SSID 

Sets the SSID of the internet access 

point. 

Enter the SSID for the access point that 

you will use. An SSID of up to 32 

alphanumeric characters can be 

entered. 

o Access Point Password 

Set the internet access point password. 

Enter the password for the access point 

that you will use. 

o In your browser, enter http://flashair to 

view or stream your files 

http://flashair/
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For more information on the Toshiba FlashAir™ W-03 Wireless 

SD Memory Card, contact the application vendor at 

https://www.toshiba.co.jp/p-media/wwsite/contact.htm. 
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G.A.S. Gas Analysis Software 
G.A.S. software enables the user to not only calibrate the F-950, 

but also view graph displays of measurements, download, edit 

and add notes to files, create upper and lower thresholds for 

quality monitoring, and remotely navigate through the F-950 

menu system. 

A. Download the F-9xx G.A.S. software from  
https://felixinstruments.com/support/F-950/software/ 

B. Install 
C. Launch the downloaded G.A.S. program 

  
There are two ways to connect the F-950 To the G.A.S. program: 
Bluetooth or USB cable connection.  
 

 
 

1. For USB cable connection, move ahead to step 4. For 
Bluetooth connection, on your F-950, navigate to Setup > 
Mode > Connection > Bluetooth. On your windows PC 
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navigate to Settings > Devices > Bluetooth and pair your 
computer to the F-950  

 

 
2. Verify that the passcode matches between the F-950 

and the computer, accept each. 

 

3. Once verified, navigate back to G.A.S., the program will 
initiate a connection with the F-950 
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4. Once connected, your device serial number should appear 

in the upper left hand corner of the window, click on the 
serial number, you are now ready to interact with the F-
950! Click on the grey and blue square in the upper right 
hand corner to dis-connect or re-connect. 
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Menu System 
 

 

The following will describe the menu system functions and 
symbols: 
 

  
The ‘Files’ menu allows viewing of all files saved to the F-
950 
 
 
The ‘Measurement Monitor’ menu displays 
measurements graphically in real time.  

 
  The ‘Control Panel’ menu displays toggle keys which 

allow the user remote control of the F-950 

 

 The ‘Calibration’ menu navigates the user through the 

calibration process for both set zero and set span. 

 

Files   

The files menu will display all files saved to the SD card of the F-

950. 
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Just select the file of interest and choose whether to download 
the file from the device, 

 
 
Or open a saved file from your PC. 

 
  
When the document appears on the right-hand column, select it 
to view and make edits in the 'Note' section.  
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Once done reviewing and editing your data, select the save icon 
to save your changes. These changes will be saved to your pc. 

 
 
 
Measurement Monitor   
 
The Measurement Monitor menu allows the user to view a 
graphical live feed of measurements taken on the F-950. This 
feature will display the measurement mode being used, the 
selected gas, temperature, flow, and RH with the option to 
toggle between CO2, O2 and C2H4. Zoom-in and zoom-out display 
can be adjusted as well as the time interval. Left click on the line 
to see information on the data point! 
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When Trigger mode is selected, the measurements will display 
upon completion in consecutive rows, where the user can again 
edit and add notes to the data. 

 
 
Control Panel   
 
The Control Panel Menu allows the user to control the F-950 
From a computer using a series of toggle keys seen below. 
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By pressing up or down, the user can navigate through the file 
menu to change settings on the unit and use the square button 
to take a measurement. 
 
Calibration 
   
The Calibration menu enables a two-point calibration process 
for the F-950, including Zero Calibration and Span Calibration. 
The set zero process will require known standard gas of 100% 
Nitrogen (N2) gas to set a zero baseline. Next the user will be 
prompted to connect a known standard gas to set the span for 
your sensors. For more information on the standard gases 
needed for calibration refer to page 
_Ref477940619 \h 26 of the user 
manual.  

 
Each sensor will require its own standard gas for calibration. 
After the set span is complete it is best practice to verify your 
calibrations were successful by reading the standard gas to 
ensure accuracy. 
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Settings 
G.A.S. offers a settings menu allowing the user to switch 
between continuous and trigger modes, as well as setting 
thresholds for QA monitoring. 
  

 
  
 
The user has the flexibility to create a customized validation 
profile, creating unique profile names and threshold values for 
each gas of interest, useful for quality monitoring! 
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Simply "apply validation profile" created after selecting your 
customized validation profile, and then proceed to see your 
results in the Measurement Monitor display. 
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Firmware Update 
To update the firmware on the F-950, you will need to 

download and install G.A.S. as outlined in the previous section. 

Launch the software, connect your device and select “Help”. 

 

 

This will reveal a menu with the option to update your 

firmware. 
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Once “Upgrade Device Firmware” is selected, the software will 

outline a series of steps for the upgrade. 

 

Follow the instructions provided in steps 1 and 2, step 3 

requires the selection of a .dfu file, which can be downloaded 

from: https://felixinstruments.com/support/F-950/software/ 

Once the file is downloaded to your computer and selected in 

step 3, click install as prompted in step 4. 

You will be prompted to wait while the firmware upgrades. 
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Followed by a confirmation that the firmware uploaded 

successfully. Press “OK” and proceed to power on the unit by 

pressing and holding the power button for 10 seconds. You’re 

done! 

 

 

Maintenance of your F-950 Three Gas 

Analyzer 

 

Long Term Storage of the F-950 
WARNING: If you plan to store this device for longer than 

one month, follow the instructions below on how to 

disconnect the O2  and C2H4 sensors from the board. This 

will prolong the life of the O2 and C2H4 sensors. 

1. Turn off the F-950 Three Gas Analyzer And remove 
the bottom rubber mat.  

2. Remove the battery cap (it’s spring loaded!) and 
unscrew the black bottom plate of the F-950. 
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3. Unplug the connector for the ethylene sensor by 

gently pulling it out. 

 
4. Unplug the red and black cable connector by gently 

pulling the fastener out the end of the O₂ sensor. 
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5. After reconnecting the sensors, insert fully charged 

batteries and allow 24 hours to stabilize the 
sensors.  

 

Replacing the Oxygen (O₂) Sensor 
The oxygen sensor has a life span of two (2) years, and the 
replacement of the sensor is simple and quick. To purchase the 
sensor from Felix Instruments contact 
sales@felixinstruments.com. To replace the sensor refer to 
images on following page: 
 

6. Turn off the F-950 and remove the bottom rubber mat.  
7. Remove the battery cap (it’s spring loaded!) and 

unscrew the black bottom plate of the F-950.  
8. Unplug the red and black cable connector by gently 

pulling the fastener out the end of the O₂ sensor. 
9. Unscrew the O2 sensor (counter-clockwise). 
10. Screw in the new sensor (clockwise) until you feel a 

resistance—not too tight! 
11. Plug in the cable connector by pressing the white 

fastener into the end of the new O2 sensor. 
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12. Screw the bottom plate into position, and fasten the 
battery cap. 

13. Place the bottom rubber mat—and congratulations 
you’ve done it! 

14. Photos of the process are below. 
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Replacing the Potassium Permanganate Filter 

(KMnO4) 
The Potassium Permanganate will expire after prolonged use 

and can be identified when the granules turn dark purple to 

brown. The small black jar is the KMnO4 filter, just unscrew the 

bottom plate of the F-950 unit after removing the battery cap, 

unscrew the filter, screw in the replacement and you’re done! 

Screw back into place the bottom plate and finally the battery 

cap. 
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Appendix I: Sampling from a Jar 
 
The following photos utilize a glass jar customized with the 
addition of a Vacutainer® septum. 
The F-950 can draw and analyze a headspace gas sample from a 
rigid jar by incorporating an input probe and output flow into 
the septum to compensate for removed airspace, thus 
preventing a vacuum from occurring.  
 
Instructions: 

1. With the F-950 in Trigger mode, allow the instrument to 
purge and stabilize in ambient air before inserting the 
sampling probe into the sample jar septum. 

2. Once stabilization is complete, insert the sample needle 
probe connected to the F-950 inlet into the jar septum. 

3. To prevent a vacuum, insert another probe from the 
outtake of the F-950 into the septum. The loop back 
tube provided with the F-950 can be utilized for this 
purpose. There are now two needle probes inserted 
into the septum. 
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4. Press the square button above the name of the 

instrument to initiate the Trigger mode measurement. 
The pump inside of the F-950 will activate and draw 
headspace gas into the unit. 
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*If you receive a Clogged probe? error, check that your needle is 
not bent and that the needle has penetrated through the 
septum and into the sampling space. 
For larger sampling jars, consider incorporating an internal fan 
to improve circulation within the sample space. Carbon dioxide 
gas can sink to the bottom portion of the jar, rendering a non-
representative reading to occur. Placing the jar on a long side 
helps to mitigate this from affecting the sample draw and more 
evenly distributes the internal gas. 

  

mailto:sales@felixinstruments.com
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Appendix II: Guide for Purchasing 

Standardized Gases for Calibration 
When deciding which standard gases to purchase for 

calibration, there are some important considerations that will 

help guide your purchase: 

1) Determination of concentration of the gas to be 

purchased. The concentration of the standard gas is 

the first consideration. It needs to be at a 

concentration level that is appropriate for 

calibration of the instrument.  

 

2) Determination of proper regulator for the standard 

gas tank. A regulator is needed to provide a 

consistent flow of gas to the instrument at a certain 

rate. At our facility, we use on-demand regulators 

that require the pumps within our instruments to 

pull the gas from the standardized tank. If this is not 

an option, other regulators are acceptable, just use 

a T-junction when connecting to the instrument to 

protect the instrument from damage.  

 

3) Determination of the size of tank to order. Consider 

how many calibrations can be performed with the 

volume of gas purchased. Each calibration for the F-

920, 940, and 960 will take around 0.3 liters of 

standard gas.  

Below is an example of a standard order our company would 

make to Air Liquide for a 1.5ppm ethylene standardized gas 

tank for calibration of the F-950. 
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Air Liquide is a multi-national company that can deliver 

products to most business locations worldwide.  You may look 

at www.airliquide.com for your local office. 

Air Liquide America Specialty Gasses LLC  

Telephone 425-931-8303 or 800-814-4642 

A sample order for 34 Liter canister of appropriate calibration 

gas for an F-950 or F-950 would include the following (Note, 

these are Air Liquide’s unique product numbers): 

 

Part number A0909352

 Sco

tty 34 

Description: Two 

component 

mailto:sales@felixinstruments.com
http://www.felixinstruments.com/
http://www.airliquide.com/
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mix: 

Balance air, 

gas 34, NR 

Ethylene 

1.5ppm 

balanced 

with air 

 

Phase Cylinder gas 

Measurement Mole 

Class N/A 

Size 34L 

Your gas vendor will do their best to meet your specified 

concentration and will provide a certificate of analysis with your 

gas showing what they have delivered. Be certain to use the 

actual value on the certificate of analysis as it may differ from 

what you have ordered. 

If you don’t already own a regulator, you must buy one. The 

following is the ordering information  for the on-demand style 

regulator that we typically use. (Note, these are Air Liquide’s 

unique product numbers) 

Part Number: A0315576 

Description: Q114DRFRC10 – M14 Demand 

Regulator 

0 – 3 LPM @ 3’ 
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Warranty Information 
 

Seller's Warranty and Liability: 
  
Felix Instruments- Applied Food Science warrants new 
equipment of its own manufacturing against defective 
workmanship and materials for a period of one year from 
date of sale. The results of ordinary wear and tear, neglect, 
misuse, accident and excessive deterioration due to 
corrosion from any cause is not to be considered a defect.  
Felix Instruments’ liability for repairing or replacing 
defective parts during the warranty period is contingent 
on examination by a Felix Instruments authorized 
representative. Felix Instruments liability will not extend 
beyond repairing or replacing parts from the factory where 
they were originally manufactured. Repair or alteration by 
an unauthorized technician voids warranty.  
Material and equipment which is not manufactured by 
Felix Instruments is to be covered only by the warranty of 
its manufacturer. Felix Instruments will not be liable to the 
Buyer for loss, damage, or injury to persons or to property 
by the use of equipment manufactured by other 
companies.  
 
Buyer accepts the terms of warranty through use of this 
instrument and any accessory equipment. There are no 
understandings, representations, or warranties of any 
kind, express, implied, statutory, or otherwise (including, 
but without limitation, the implied warranties of 
merchantability and fitness for a particular purpose), not 
expressly set forth herein. 

mailto:sales@felixinstruments.com
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All instrument repairs or replacement covered under 
warranty require a Returned Material Authorization (RMA) 
number. Please contact Felix Instruments technical 
support department at support@felixinstruments.com to 
obtain an RMA number before shipping instrument to CID 
Bio-Science, Inc.  
 
Buyer is responsible for shipping charges to Felix 
Instruments headquarters: 
 
1554 NE 3rd Ave. 
Camas, WA 98607 
USA 
 
Felix Instruments is responsible for return shipping charges 

on repairs and/or replacement covered by warranty. 
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Warranty Registration Card 

 
1554 NE 3rd Ave, Camas, WA 98607, USA 
Phone: (360) 833-8835  Fax: (360) 833-1914  e-mail: sales@felixinstruments.com Web: www.felixinstruments.com 
  

PRODUCT REGISTRATION CARD 

Please complete and return this form to Felix Instruments within 30 days to validate your Warranty on Parts & Labor. 
    
Registration Information: 
  

Your Name:____________________________________ Title:__________________ 

Company/University:___________________________________________________ 

Address:_____________________________________________________________  

City:____________________________ State:__________ Zip:__________________ 

Country:__________________________Email_______________________________ 

Phone:______________________________ Fax:____________________________ 

Felix Instruments Serial Number(s):__________________________________________________  

Purchase Date:_____________________Purchase Price:_____________________  

------------------------------------------------------------------------------------------------------------------ 
FOLD ON DOTTED LINE 

   
  
Your opinions will help improve our service. Please answer the following questions. 
 
1. What was the basis of your product selection? 
□ Representative Recommendation    □ Price 
□ Product Features     □ Product Design 
□ Technical Specifications     □ Brand Name 
□ Warranty       □ Service 
□ Other _________________________________________ 
 
2.  What other competing brands did you consider? __________________________ 
 
3. Where did you first learn of this product? 
□ Advertisement in ________________________________   □ Representative 
□ Friend/Colleague     □ Exhibit 
□ Other _________________________________________ 
 
4. Who selected this product? 
□ I did      □ Research Group 
□ University Department     □ Purchasing 
□ Other _________________________________________ 
 
5. Comments/Suggestions:  
______________________________________________________________________ 

______________________________________________________________________ 

mailto:sales@felixinstruments.com
http://www.felixinstruments.com/

